26 Permissions

Permissions restrict access to applications unless a person has been given a TermSecure login and the
matching permission set.

26.1Creating Permissions Groups

Permissions grant or limit access through the TermSecure Access Groups. Select the Permissions button in
the Terminal Configuration Wizard, the Terminal Group Configuration Wizard, the Display Client
Wizard, the TermSecure User Wizard, or the TermSecure Users Group Wizard to set these up.

e Terminal Permissions is the list of named permission groups whose members may
access a terminal. The Unrestricted group does not require a membership to access.

e Terminal Group Permissions is the list of named permission groups whose members
may access a terminal belonging to the Terminal group. The Unrestricted group does
not require membership to access.

e Display Client Permissions is a list of named permission groups whose members may
access and view a Display Client. The Unrestricted group does not require a login.

e TermSecure User Permissions is a list of named permission groups to which a
TermSecure User belongs.

e TermSecure User Group Permissions is a list of named permission groups to which
members of a TermSecure User Group belong.

A TermSecure User can use a terminal when they share membership in a TermSecure Access
Group.

A TermSecure User can use a Display Client when they share membership in a TermSecure
Access Group.
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26.1.1.1 Creating a TermSecure Access Group

Selecting Manage > TermSecure Access Groups from the ThinManager menu will launch the Access
Groups window.

Access Groups |

nrestncted
Al Users

Edit

[=

Add

Delete

i

Access Groups Window with Default Groups

Select the Add button to add an Access Group. The Add button launches an Access Group window.

Access Group

=]
Enter Group Hame

|| Cancel

E dit Members |

Permission Group Creation Window

Enter a name for the new TermSecure Access Group and select OK to create the group.
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Access Groups

IJrrestricted 0]
Al Jzers
S LIpEMiSOrE

ITzervices

Edit

-kl

&dd

Delete

[

Additional TermSecure Access Groups Created

The created Access Groups will be displayed in the Access Group window. These TermSecure Access
Groups, like Microsoft User Groups, do not have settings and parameters, but instead get their usefulness by
adding members to them or applying restrictions to them.

26.2Permission Groups for Terminals

TermSecure Access Groups are assigned to a terminal with the Permissions button on the first page of the
Terminal Configuration Wizard.

Note: Removing the Unrestricted group from a terminal and replacing it with a TermSecure Access group will
render the terminal functionless until a member of the group logs in.

Open the Terminal Configuration Wizard for an existing terminal by double clicking on it in the tree. Start the
Terminal Configuration Wizard for a new terminal by selecting Edit > Add Terminal.
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22 Terminal Configuration Wizard

Terminal Name ("
Enter the name for this teminal, select the terminal group to which } ‘
this terminal belongs, or choose to copy the corfiguration from A
another terminal.

— Terminal Mame

Siema

This must be a unigue name using letters, numbers, yphens (),
and underscores (_) only.

— Terminal Group

I Change Group |
— Copy Settings
[T Copy Settings from another Teminal Copy Frarm |
cBack | Mets | Fueh | Cancel Help

Terminal Configuration Wizard

Select the Permissions button on the first page of the Terminal Configuration Wizard to launch the
Permissions window to apply the TermSecure Access Groups to the terminal.

Permissions |

TermSecure Acces: Groups

Aoailable tember OF

Al Uzers
ITzervices
Supervizors

1
<

Permissions Window

Automation Control Products ThinManager 5.0 Help Manual Permissions e 468



By default, the terminal uses the Unrestricted access group, allowing anyone access to the Display Clients
that are assigned to the terminal.

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or
highlighting the desired group and selecting an arrow.

Permissions |

TermS ecure Accesz Groups

Ayailable tember Of

Al Uszers
ITzervices
nrestricted

|« |~

Object Permissions

If the terminal has the Unrestricted access group removed from Member Of list and is replaced by other
Access Groups, TermSecure will deny access to the terminal except for members of the selected access
groups.

Note: Removing the Unrestricted group from a terminal and adding a different group will render the terminal
functionless until a member of the group logs in.

Select OK to close the Permissions window.

26.3Permission Groups for Display Clients

TermSecure Access Groups are assigned to a Display Client with the Permissions button on the first page of
the Display Client Wizard.

Open the Display Client Wizard for an existing Display Client by double clicking on it in the tree. Start the
Display Client Configuration Wizard for a new Display Client by right clicking on the Display Client branch icon
and selecting Add Display Client.
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5%\ Display Client Wizard

Client Name m
Enter the Display Client name. } ‘
Client Mame HMI

Type of Display Cliert
Terminal Services j
< Back Mexd = Finish Cancel Help

Display Client Configuration Wizard

Select the Permissions button on the first page of the Display Client Configuration Wizard to launch the
Permissions window to apply the TermSecure Access Group to the Display Client.

Permissions |

TermSecure Access Goups

Anailable tember Of
Al Users
ITservices
Supervizors

Permissions
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By default, the Display Client uses the Unrestricted access group, allowing anyone access to the Terminal
Server.

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or
highlighting the desired group and selecting an arrow.

Permissions |

TermS ecure Accesz Groups

Ayailable tember Of

Al Uszers
ITzervices
nrestricted

|« |~

Permissions Changed

If the Display Client has the Unrestricted access group removed from Member Of list and is replaced by
other Access Groups, TermSecure will deny access to the terminal except for members of the selected
access groups.

Note: Removing the Unrestricted group from a terminal and adding a different group will hide the Display
Client until a member of the group logs in.

Select OK to close the Permissions window.

26.4Permission Groups for TermSecure Users

TermSecure Access Group permissions can be applied to TermSecure Users. This is useful for
SecureAccess or Terminal-specific Applications.

Create a TermSecure User to apply the permissions by right clicking on the TermSecure User branch of the
ThinManager tree and selecting Add TermSecure User.

TermSecure Access Groups are configured on the first page of the wizard by selecting the Permissions
button.
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26.4.1.1 TermSecure User Information

22 TermSecure User Configuration Wizard

TermSecure User Information
<

Erter TermSecure usemame, password and pemission infamation.

— TermSecure User Information

|Iser Name I;’-‘-J:Iam

Password

I

Verify Password I“"‘“

Password Options |

— Eroup

I Change Group

— Copy Settings

[T Copy Settings from another Lzer Copy Franm

Pemissions |

CHE Next > Fish | Cancel Help

TermSecure User Information

Selecting the Permissions button will open the Permissions window that allows the assignment of a
TermSecure Access Groups.

Permissions |

TermSecure Access Goups

Anailable tember Of
ITservices :

Permissions
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The Permissions window for TermSecure Users does not show the Unrestricted or the All Users groups,
just the created groups. Access can be granted or denied by moving the Access Groups into or out of the
Member Of list by double clicking or highlighting the desired group and selecting an arrow.

Select OK to close the Permissions window.

Select Next to continue with the TermSecure User Configuration Wizard.

26.4.1.2 Card / Badge Information

The second page of the TermSecure User Configuration Wizard is the Card/Badge Information page.
52\ TermSecure User Configuration Wizard |

Card / Badge Information w
Enter card/badge information f user has one. } ‘
o

[ iThiz uzer will use a card, badge, or other device to log in:

—Card / Badge Information

Enter Card/Badge |10 number

[T &lways Prompt for Pazswornd

< Back Mext = Finish Cancel Help

Card / Badge Information Page

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See
Card and Badge Configuration for a TermSecure User for details

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will
need the appropriate module added. See TermSecure Modules for details.

Select the Next button to continue with the configuration.
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26.4.1.3 Display Client Selection
The next page of the TermSecure User Configuration Wizard is the Display Client Selection page.

58 TermSecure User Configuration Wizard |

Display Client Selection

Select "Yes" to specify Display Clients for this user. } ‘
)

Add Userspecific Display Clients 7

Answer "es" here f you want to select userspecific Display Clients in
addition to the Display Clients that are in the terminal configuration.

Any userspecific clients will be added to the clients specified in the teminal
configuration.

< Back Mest = Finish Cancel Help

Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User.

Add User specific Display Clients? - This setting, if set to No, will allow the TermSecure User to access the
display client hidden on a terminal with the TermSecure Access Group permissions. This is used with
SecureAccess or Terminal-specific Applications.

This setting, if set to Yes, will allow the selection of Display Clients for the TermSecure User that will be
added to the terminal when the TermSecure User logs in top the terminal. This is used with SmartContext or
User-specific Applications.

Select the Next button to continue with the configuration.
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26.4.1.4 Terminal Interface Options

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page.
5% TermSecure User Configuration Wizard |

Terminal Interface Options ﬂ

Select the group selector and main menu options that will be
available on the teminal. N

— Display Client Selection Options
[ Use Temminal Settingsi

¥ Show Selector on Teminal Selector Options |

[~ Enable Tiling Tilirig [ ptichs |
[~ Screen Edge Display Client Selection

Main Menu Options

Main Menu Options

< Back Mest = Finish Cancel Help

Terminal Interface Options

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal
using MultiSession will need to have a method to switch between sessions.

See Terminal Interface Options for details.
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26.4.1.5 Terminal Hotkey Options

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page.

5% TermSecure User Configuration Wizard |

Termminal Hotkey Options (.,
Select the haotkeys that will be available on the teminal . ’ 5

~ Terminal Hotkeys

[™ Use Teminal Settings:
I~ Enable Instant Failover Hotkeys [Change Haotkeys |
[¥ Enable Display Client Hotkeys Change Hotkeys |
I™ Enable Tiing Hotkey Change Hofiey |
< Back Mest = Finish Cancel Help

Terminal Hotkey Options

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that
allow switching between sessions.

See Terminal Hotkeys for details.
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26.4.1.6 User Options
The final page of the TermSecure User Configuration Wizard is the User Options page.
5% TermSecure User Configuration Wizard |

U=zer Options F;"

Select options for this user.

—Log In / Log Out Options
Inactivity Timeout 1.20 seconds
Reset Sessions at Logout r
Activate User Group at Log In r
— User Schedule
[ Set Schedule Schedule |
— Terminal Efects
¥ Enable Teminal Efects
— Shadowing
Allow teminal to be shadowed YES Bl
¥ Allow Interactive Shadow

« Bacit Hent > | Fish |  Cancel | Help

User Options

See User Options for details.

Select Finish to finish the configuration.

26.5Shortcut Method of Adding TermSecure Access
Groups

Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group
Wizard.

Open the TermSecure Access Group Wizard by selecting Manage > TermSecure Access Groups from the
ThinManager menu. This will launch the Access Groups window.
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Access Groups

IJrrestricted
Al Users

Levell
Lewvel?

K

Edit

-kl

&dd

Delete

[

Access Groups Window

Highlight the desired TermSecure Access Group and select the Edit button.

Access Groups E |

Inrestricted
Al Uszerz

Levell
Level?

Access Group

E nter Group Mame
Edit tembers |

Access Group Window

Select the Edit Members button to launch the Access Group Members window.
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Access Group Members

& Teminals

" Teminal Server Groups " TemSecure Users

Terminal Mame

| Terminal Path

Cancel

i

&dd

Remove

[

Access Group Members Window

Select the Terminals, Display Clients, or TermSecure Users radio button to configure that category and

Select Terminal | x| |

select the Add button.

[=]- Terminals
- MasterGroup
- 1_5820
2 UWD
3 _Anstahi24
4 Spare
e B WARTMC

Cancel

ok I
[Eem=

Select Terminal Window

A Select Terminal window will be displayed with a tree of the configured terminals and terminal groups.
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Select the desired terminals and terminal groups and select OK for each addition.

Access Group Members

" Teminals

™ Dizplay Clients i~ TemSecure Users

Termninal Mame

| T erminal Path |

Q Term3

Cancel

x|
ak. |
L

Femove |

Access Group Members

The Access Group Members window will show the members of the TermSecure Access Group. These can be
removed by highlighting and selecting the Remove button.

Display Clients and TermSecure Users can be added by the same process of adding by selecting the

appropriate radio button.

Access Group Members

" Terminals

select Application Group

* fpplication Groups " TemSecurs Users

Applicatiaon
ﬁ i Report:

ESktDp_EIau:k
Deszktop_Cream = |
Desktop_Green ance |
Desktop_Tan

Graphicz

Reparts

Shadow_5E20
Shadow_ Ay

]|

i —_————=

E|
k. |
_ Carcsl |

Cancel

Femove |

Display Client Selection
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Access Group Members

= Teminals * Application Groups " TemSecurs Users ok

Cancel

Application Group |

@ Analytics
Add
@ Reparts

Remove

R

Member Display Clients

Members can be removed by highlighting them and selecting the Remove button.

26.6TermSecure User Configuration Wizard

A TermSecure User can be configured with a user name, password, and user-specific Display Clients. When
the user logs into a terminal with that identity, TermSecure will allow the user access to the personalized
Display Clients for that user in addition to the Display Clients already assigned to the terminal.

Note: The TermSecure Users branch of the ThinManager tree will not be visible unless a Master License is
installed on the ThinManager Server.

The TermSecure User Configuration Wizard is launched by right clicking on the TermSecure Users branch
of the ThinManager tree and select Add TermSecure User.
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26.6.1.1 TermSecure User Information
The first page of the TermSecure User Configuration Wizard is the TermSecure User Information page.

== TermSecure User Configuration Wizard |

TermSecure User Information W
.-.‘

Erter TermSecure usemame, password and pemission infomation.

— TermSecure User Information

|ser Mame |

Password I
Verfy Password I

Password Options |

—Group

I Change Group

[T Copy Settings from anaother Lser Copy Fram

— Copy Settings

Pemissions |

Flease enter a name

cBack | e | Fish | [ Cancel | Help

ThinManager User Information

The TermSecure User Information has fields for the user name and password that will be used by the
TermSecure User to log into ThinManager security to access TermSecure functions.

The TermSecure User Information is for account information:

e User Name - Enter the user name that the user will use to log into the TermSecure system. Although
this can be the same as the Windows user name, the TermSecure user name is independent of the
Microsoft Windows login. This TermSecure user name can be tied to a Windows login later in the
wizard on the Windows Login Page.

e Password - Enter the password for the TermSecure User in this field.
o Verify Password - Re- enter the password for the ThinManager User in this field.

e The Password Options button launches the Password Maintenance Options window that
regulates rules for the ThinManager User password.
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Password Maintainance Options |

— Paszword Complexity Beguirements

Minimum Pazzword Length ||!1

[ Must contain numberz [ Must contain symbols
[ Must contain capital letters

— Paszword Maintainance

[T Allow User to change password
™ Force User bo change password at next login

[ Force Uzer to change password periodically

Izer musgt change pazswaord every I danz
Cancel | ] I

Password Maintenance Options

Password Complexity Requirements:

e Minimum Password Length - Sets the amount of characters that the password must contain to be
valid.

e Must contain numbers - This checkbox, if checked, will require that the password contain at least
one number in it.

e Must contain symbols - This checkbox, if checked, will require that the password contain at least
one symbol in it.

e Must contain capital letters - This checkbox, if checked, will require that the password contain at
least one capital letter in it.

Password Maintenance:

e Allow User to change password - This checkbox, if checked, will allow the user to change the
password at the TermSecure menu.

e Force User to change password at next login - This checkbox, if checked, will require the user to
change the password at the TermSecure menu when they login the next time.

e Force User to change password periodically - This checkbox, if checked, will require the user to
change the password at the TermSecure menu on the schedule set by the User must change
password every X days field.

e User must change password every X days - This field sets the time period between the scheduled
password changes caused by the Force User to change password periodically checkbox.

The OK button closes the window with any changes. The Cancel button closes the window without changes.
Group:

e The Change Group button opens the Choose User Group window that allows a User to be placed
in an existing TermSecure Users Group.
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Choose User Group

5|
El- U_sers QK I

=1 East

- Delaware Cancel
- b aryland
- Mework,
[=]- Morth

- Michigan
- Ohino

- Wizconzin
= South

- Florida

- [Ae0rgia
= West

- Arizoha

- Califormia
- Mevada

Choose User Group

If TermSecure User Groups have been created, the Choose User Group window will display the
TermSecure User Group branch of the ThinManager tree.

To add the TermSecure User to a TermSecure Users Group, highlight the desired TermSecure Users
Group and select the OK button.

To change the TermSecure User to a different TermSecure Users Group, highlight the desired
TermSecure Users Group and select the OK button.

To remove the TermSecure User from all TermSecure Users Groups, highlight the top-level Users
branch and select the OK button.

The OK button closes the window with any changes. The Cancel button closes the window without changes.

Copy Settings:

The Copy Settings from another User checkbox, if selected, activates the Copy From button that

allows the configuration of an existing TermSecure User to be applied to the current TermSecure
User.

The Copy From button opens the Select User window that allows the selection of the desired
TermSecure User configuration.
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Select User

5|
El- U_sers QK I

[+ East
= Marth Cancel
EI Wiscunsin

i BillCheddar

i MaryMozzarella

[+ South

[+ "West

- Bdams

- Jefferson

- Madizon

- Monroe

- Wy aghinighan

Select User Window
The Select User window will show a tree with the existing TermSecure User Groups and the TermSecure
Users.

Highlight the TermSecure User whose configuration you want to copy and select the OK button. The OK
button closes the window with any changes. The Cancel button closes the window without changes.
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26.6.1.2 Card / Badge Information
The next page of the TermSecure User Configuration Wizard is the Card/Badge Information page.

5% TermSecure User Configuration Wizard |

Card / Badge Information w
Erter card/badge information f user has one. } ‘
A

[ This user will use a card, badge, or other device to log in!

—Card / Badge Information

Enter Card/Badage |0 number

[T &lways Prompt for Pazsword

< Back Meast = Finish Cancel Help

Card / Badge Information Page

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See
Card and Badge Configuration for a TermSecure User for details

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will
need the appropriate module added. See TermSecure Modules for details.

Select the Next button to continue with the configuration.
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26.6.1.3 Display Client Selection
The next page of the TermSecure User Configuration Wizard is the Display Client Selection page.

& TermSecure User Configuration Wizard |

Display Client Selection

Select "Yes" to specify Display Clients for this user. * ‘
A

Add Userspecific Display Clients 7

Answer "es" here f you want to select userspecific Display Clients in
addition to the Display Clients that are in the terminal configuration.

Any userspecific clients will be added to the clients specified in the teminal
configuration.

< Back Mest = Finish Cancel Help

Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. When the
TermSecure User logs onto a terminal, these Display Clients will be available on the terminal for him.

Add User specific Display Clients? - This setting, if set to Yes, will allow the selection of Display Clients for
the TermSecure User that will be added to the terminal when the TermSecure User logs in top the terminal.
This provides the user-specific Display Clients.

This setting, if set to No, will rely on Permissions to grant access to terminal-specific Display Clients.
Select the Next button to continue with the configuration.
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26.6.1.4 Display Client Specification

The next page of the TermSecure User Configuration Wizard is the Display Client Specification page.

5% TermSecure User Configuration Wizard |
Display Client Specification m‘
Select the Display Clients to which this user can connect. ’ ‘
A
Awailable Display Clients Selected Display Clients

E HelpDesk ﬂﬂepnrts

E; |'| a I:I L _,".‘."

@XP] 1 | ﬂ

1
[T
o 1
= B
o
=]
|A|v

@ LoadingDock

Edit Display Clients Cvemde |

< Back Mest = Finish Cancel Help

Display Client Specification Page
The Display Client Specification page allows Display Clients to be assigned to the TermSecure User if the
Add User specific Display Clients? radio button is set to Yes.

Move a Display Client you want the TermSecure User to use into the Selected Display Clients list by
double-clicking on it in the Available Display Clients list or by highlighting it and clicking the Right Arrow
button.

To add a new Display Client, select the Edit Display Clients button to launch the Display Client Wizard. See
Display Client List for details.

Select the Next button to continue with the configuration.

Automation Control Products ThinManager 5.0 Help Manual Permissions e 488



26.6.1.5 Windows Login Information
The next page of the TermSecure User Configuration Wizard is the Windows Log In Information page.

& TermSecure User Configuration Wizard |

Windows Log In information W
Erter Windows usemame and password information } . ‘

—Windows Log In Information

[ Use Teminal Configuration Login Information:

[~ Same as TemmSecure User usemame/password

|Isemame

Werify Password

|
Password I
|
|

Domain

< Back Mext = Finish Cancel Help

Windows Login Information

The Windows Log In Information page allows the configuration of how the TermSecure User will log on to
the Windows terminal servers.

There are several Windows login options for the TermSecure User.

1. The TermSecure User can use the terminal’s username and password to auto-log on to the terminal
server. To do this, check the Use Terminal Configuration Login Information checkbox

2. The TermSecure User can use the TermSecure User username and password to auto-log on to the
terminal server. To do this, check the Same as TermSecure User username/password checkbox.
The TermSecure User username and password must match a Windows User username and
password to get authenticated by Windows.

3. The TermSecure User can use a separate username and password to auto-log on to the terminal
server. To do this, use the fields for the Username, Password, and Domain that are provided.

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the
checkboxes unchecked and the Username, Password, and Domain empty.

Select the Next button to continue with the configuration.
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26.6.1.6 Terminal Interface Options

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page.

5% TermSecure User Configuration Wizard |

Temminal Interface Options m
Select the group selector and main menu options that will be } - ‘

available on the teminal.

— Display Client Selection Options
[ Use Temminal Settingsi

¥ Show Selector on Teminal Selector Options |

[~ Enable Tiling Tilirig [ ptichs |
[~ Screen Edge Display Client Selection

Main Menu Options

Main Menu Options

< Back Mest = Finish Cancel Help

Terminal Interface Options

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal
using MultiSession will need to have a method to switch between sessions.

Group Selector Options allow on-screen switching of sessions.

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties
that were configured for use with the terminal.

Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

Enable Tiling - This checkbox, if selected, allows the sessions to be tiled so that the user can make a
visual selection of the desired selection.

Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

Selector Options - This button, if selected, will launch the Group Selector Options window.

Tiling Options - This button, if selected, will launch the Tile Options window.
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Display Client Selector Options

[ Tile on Selector activation Cancel
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Group Selector Options Window

The Group Selector Options window has several settings.

The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to
that space.

The Tile on Group Selector checkbox, when selected, will tile the Display Clients when the auto-hid
selector is chosen. This allows the user to select from the available sessions.

Select the OK button to accept changes or the Cancel button to close.

The Tiling Options button will launch the Group Selector Options window that allows configuration of the
on-screen Group Selector bar.

Tile Options |

Tile Inactivity Time IEEI Cancel |

[T Tile Dizplay Clients at startup

[ Include Main Menu as tile

[T Tile onright click [mouse or touchscreen)

[T Tile Interactive

Tile Options

The Tile Options window has several settings.

Show Grid — This checkbox, when selected, will show the tiled sessions in a grid with each grid
labeled with the session name as while the session is loading.

Tile Inactivity Time — This field sets the length of time that the terminal screen will stay focused on a
selected session before reverting back to a tiled state due to inactivity.

Tile Display Clients at startup — This checkbox, when selected, will show the sessions tiled when
the terminal first connects to its sessions.

Include Main Menu as tile — This checkbox, when selected, will include a session displaying the
TermSecure Main Menu.

Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling when
a session is right clicked.

Tile Interactive — This checkbox, when selected, will allow a user to click into a tiled session and
control it interactively without switching focus to a single session. To focus on a single session use
the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled.

Select the OK button to accept changes or the Cancel button to close.
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The Main Menu Options button will launch the Main Menu Options window that allows configuration of the
TermSecure Main Menu.

Main Menu Options Ed |

[~ Usze Teminal 5ettings

[ Allow reboot # restart

Cancel |

¥ Show Main Menu on Selector

Main Menu Options Window
The Allow Reboot/Restart checkbox, if selected, will add a Reboot and Restart button to the main menu.

26.6.1.7 Terminal Hotkey Options

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page.

& TermSecure User Configuration Wizard |
Temminal Hotkey Oplions @
Select the hotkeys that will be available on the teminal. ’ . ‘
~ Terminal Hotleys ———
[ Use Temminal Settings:
[~ Enable Instant Failover Hotkeys [Change Hatkeys |
[v Enable Display Client Hotkeys Change Hotkeys |
[¥ Enable Tiling Hotkey Change Hotley |
< Back Mext = Finish Cancel Help

Terminal Hotkey Options
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Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that
allow switching between sessions.

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties
that were configured for use with the terminal.

e Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between
the two active sessions of a Display Client that is using Instant Failover.

e Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different
sessions of a terminal using MultiSession.

o Enable Tiling Hotkey — This checkbox, if selected, allows SessionTiling to be activated by a hotkey
combination.

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the
hotkeys to be changed from the default.

Select Hotkeys |
— Ingtant Failover Hatkey
@ Conholkey  [Fo =] Cancel |
Al Key

Select Instant Failover Hotkeys

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the
Alt Key radio button or using the drop-down to select another function key.

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the MultiSession
switching hotkeys to be changed from the default.
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Select Hotkeys

Al Key

— Mext Dizplay Client Hotkey

I Fage Down j

= Control Key

i Al Key

— Previouz Dizplay Client Hotkey

FPage Up j

Select MultiSession Switching Hotkeys

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can
be changed by selecting the Alt Key radio button or using the drop-down to select another hot key.

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to be

changed from the default.
Select Hotkeys

— Tile Hotkey

Al Key

=]|

Cancel |

Select SessionTiling Hotkeys

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the Alt
Key radio button or using the drop-down to select another hot key.

Select the OK button to continue or the Cancel button to close without accepting changes.
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26.6.1.8 User Options
The final page of the TermSecure User Configuration Wizard is the User Options page.

= TermSecure User Configuration Wizard |

Select options for this user.

Uzer Options a

— Log In / Log Out Options
Inactivity Timeout 120 seconds
Reset Sessions at Logout r
Petivate User Group at Log In r
— User Schedule
[ Set Schedule Schedule |
— Terminal Effects
¥ Enable Teminal Effects
— Shadowing
Allow teminal to be shadowed YES i
¥ Allow Interactive Shadow

< Back Hent > | Fish |  Cancel | Help

User Options

Log In / Log Out Options

e Inactivity Timeout - TermSecure will log a TermSecure Users off the terminal after this much
inactive time has passed.

e Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the TermSecure
User logs off.

e Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s first
Display Client when the user logs in to the terminal.

User Schedule
e Set Schedule -

Selecting the Schedule button on the User Options page will launch the Event Schedule window and allow
a schedule to be created for terminal events.

See Terminal Schedule for details.

Terminal Effects
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e Enable Terminal Effects - This allows the use of Terminal Effects. This currently includes sliding
Windows and message rollups.

Shadowing

e Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing
Options.

(0]

(0]

(0]

No - Prevents the TermSecure Users from being shadowed.

Ask - Will display a message window that will prompt for a positive response before the
shadowing is allowed.

Warn - Will display a message window alerting the terminal that it is to be shadowed, but
doesn’t require a positive response before the shadowing is allowed.

Yes - Allows shadowing to occur without warning or recipient input.

e Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive Shadow
privileges to shadow this TermSecure User.

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting
this will prevent shadowing from within ThinManager.

Select Finish to finish the configuration.
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26.7TermSecure Users Group Configuration Wizard

TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized into
Terminal Groups. Each setting of the TermSecure Group has a Group Setting checkbox. If this box is
selected then that setting will be applied to each member of the TermSecure Group.

The TermSecure Users Group Configuration Wizard can be launched by right clicking on the TermSecure
Users branch of the tree and selecting Add TermSecure User Group.
26.7.1.1 TermSecure User Group Information

The first page of the TermSecure Group Configuration Wizard is the TermSecure User Group
Information page.

= TermSecure User Configuration Wizard x|
TermSecure User Group Information m
=

Enter the TermSecure User Group name.

— GEroup Mame

Uszer Mame |

Pazzwiord I

Werify Pazsword I

Fazsword Options | Group Setting [

— Eroup

Change Group |

Permizsiong | Group Setting [

Fleaze enter a name

< Black | Hest = | = | Cancel I Help

ThinManager User Group Information

The TermSecure User Group Information has fields for the group name and membership.
e User Name - This field names the TermSecure User Group.
Group Setting - This checkbox, if selected, applies this configuration to all members of the group.

The rest of the TermSecure Group Configuration continues as the TermSecure User Configuration, with the
addition of the Group Setting checkboxes.
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28 TermSecure User Configuration Wizard

User Group Options

Select options for users in this group

<

—Log In / Log Out Options

Inactivity Timeout
Reset Sessions at Logout

Activate User Group at Log In

Group Setting
L seconds v
r v
v 2

Group Setting v

— |User Schedule
¥ Set Schedule Schedule |
Group Setting [
— Terminal Effects
¥ Enable Teminal Efects
Group Setting [
— Shadowing
Allow terminal to be shadowed YES =
v Allow Interactive Shadow
< Back Hews> | Fish |  Cancel | Help

TermSecure Group Configuration Wizard

Group Settings that are selected will be grayed out for members of the group. Group Settings that aren't
selected will be available for configuration on the individual TermSecure User configuration page.

Automation Control Products ThinManager 5.0 Help Manual

Permissions e 498



& TermSecure User Configuration Wizard

User Options m

Select options for this user.

—Log In / Log Out Options
Inactivity Timeout 120 seconds
Heszet Sezsione at Logout [
Sativate [Uzer Group at Log ln ~
— |User Schedule
¥ SetSchedule Schedule |
— Terminal Efects
¥ Enable Teminal Efects;
— Shadowing
Allow terminal to be shadowed YES Bk
v Allow Interactive Shadow

< Back Heds | Frish |  Cancel | Help

TermSecure Group Member

Select Finish to complete the configuration.
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26.8Adding a TermSecure User to the TermSecure User

Group

To add a TermSecure User to a TermSecure User Group, create a new TermSecure User by right clicking on
the TermSecure Users branch in the ThinManager tree and select the Add TermSecure User option or

double click on an existing user to launch the wizard.

5= TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

x|
b

— TermSecure Lser Information

IJzer Mame IWashingtDn

Pazzwiord I

Werify Pazsword I

Pazzword Optionz |

— Group

Change Group I

— Copy Settings
[T Copy Settings from another Lser

Eapy Eram |

Permizzions |

cBack | Mewts | Finish

| Cancel Help

TermSecure User Information Page

Select the Change Group button. This will launch the Choose User Group window.
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Choose User Group

- Users

- East
- Delaware
- b aryland
- Mework,
[=]- Morth
- Michigan
- Ohino
- Wizconzin
= South
- Carolinas
- Florida
B 3 enrgia
= West
- Arizoha
- Califormia
- Mevada
- Central

Cancel

]|
aEk. I
_ Coreel |

Choose User Group Window

Highlight your TermSecure Users Group and select OK. This will accept the changes and close the window.
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& TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

X

<

— TemSecure User Information

Izer Mame IWashingtDn

Pazzwiord I

Werify Pazsword I

Fazsword Options |

[T Copy Settings fram another User

— Eroup
ISDuth'\G Enrgia Change Group |
— Copy Settings

Eapy Eram

Permizsiong

L

cBack | Mews | Firish |

Cancel

Help

TermSecure User Information Page

The TermSecure User Group will now be displayed in the Group field.

Select Next to continue.
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= TermSecure User Configuration Wizard x|

Card / Badge Information H

Enter card/badge information if uzer haz one.
A

[ Thiz user will uze a card, badge, or other device to log irt

— Card / Badge Information

Enter Card/Badge |0 number

™| &lways Frompt far Fasswond

< Back I Mest » I Finizh Cancel Help

Card/Badge Information

The Card/Badge Information options are available because these are individual settings, not group settings.

Select Next to continue.
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= TermSecure User Configuration Wizard x|
Display Chent 5pecification H

Select the Dizplay Clhents to which this user can connect,
A

Ayailable Digplay Clientz Selected Dizplay Clients

ShadowClient] T5Client1

ShadowClient? il
T5Client2 _—
CamClient1
CamClient2

=IR2

Edit Display Clientz | [Ivermide |

< Back Finizh Cancel Help

Display Client Specification

Each of the settings that have the Group Setting checkbox selected in the TermSecure User Group wizard
will be grayed out because the Group Setting enforces the configuration of each chosen parameter.

Select the Finish button to accept the configuration.

26.9TermSecure Login

To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox
selected on the Terminal Server Specification page.

Type the default CTL+m or other designated hotkey at the keyboard or select from group selector

The Main Menu will be displayed on the terminal.

MAAIMN MAER L

Log In AboLt
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TermSecure Main Menu

The About button to see details about the terminal.

About

Terminal Mame = Terminall
Termsecure ser Mame = MNone
IP Address =192 .168.3.101
Firmware Yersion =+3..00.01

About Menu

Select OK to close the About window.

Select the Log In button to login.

Termzecure Log On

Enter User Mame

TermSecure Log On Screen

Enter your TermSecure User user name in the Enter User Name field.
Select OK.

TermSecure Log On

Enter Password:

..............................

Password Screen
Enter the password in the field.

Select the OK button. If the user name and password are correct, ThinManager will allow the login.
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2 ThinManager [_ O] x|

Edit Manage Instal Tools View RemoteView Help

E‘"’.’ﬁ( "F"'_'_:'_t'alt Configuration | Mu:udulesl Schedulel F'n:upertiesl Event Lu:ugl Shadu:uwl Hepu:urtl
= M Terminals -
- I Attribute | Yalue -
M Group1 - —
& Terminal Identification
- Alpha (Adam) .
E‘. ool iMoo 1 Terminal Mame Alpha
Q Sierra
=N @ VCanter Servers b odel Mumber BE24-ACF
@ v_Eight_2 kM anufacturer Arizta
[ Display Clients Video Controller 53 Savaged
E| ﬁ TermSecure Lsers
m Groupl Login U semame adrnin
@ Adam (alpha) Login Comain
- D Eve Replaceable YES
Allow Shadowing YES
Allow Interactive Shadowing YES
Terminal Effects YES
Show Status Meszages YES
I1ze Dizplay Clients YES i
4| | 3
For Help, press F1 | I_ i

ThinManager With TermSecure Log On
Once a TermSecure User is logged into a terminal, ThinManager will display the TermSecure User’'s name
after the terminal name in the tree.
ThinManager will add the name of the terminal after the TermSecure User name in the tree.

Right-clicking on a terminal and selecting Go to TermSecure User will move the focus to the TermSecure
user that is logged into the terminal.

Right-clicking on a TermSecure user and selecting Go to Terminal will move the focus to the terminal that
the TermSecure user is logged into.

26.9.1 Logging Out

The TermSecure User can be logged out by:

e Opening the TermSecure Main Menu (type CTL+m) on the terminal and selecting the Log Off
button.

e Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User.

e Restarting or Rebooting the terminal that has a TermSecure User logged in.
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MAIN MEML

Switch User Log Off | About | ' Cancel |

Broorrormerroroereerroos

Main Menu

The Switch User button will log off the TermSecure User and open the Login screen for another TermSecure
User. The Log Off button will log of the TermSecure User and return to the terminal’s display.

26.10 TermSecure Menu

The TermSecure Menu that is displayed on a terminal that allows TermSecure Users to manually log on to a
terminal is configurable for use with TermSecure. This menu is generated from the terminal and not the
terminal server session.

MAA I MWAER L

Basic TermSecure Menu
The TermSecure Menu can be configured by a number of settings in the Terminal Configuration Wizard
and TermSecure User Wizard.
The Main Menu is activated on the Terminal Interface Options page of the Terminal Configuration Wizard
and/or TermSecure User Configuration Wizard.
26.10.1.1 Main Menu Configuration - Terminal Configuration Wizard

Open the Terminal Configuration Wizard by double clicking on the desired terminal in the ThinManager
tree. Terminals using Display Clients will display the Terminal Interface Options page. This page will display
Main Menu options when TermSecure is enabled for the terminal.
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= Terminal Configuration Wizard x|

Terminal Interface Oplions m
Select the display client selector and main menu options that will be }

available on the terminal. --‘

— Digplay Client Selection Options

¥ Show Selector on Terminal Selector Options |

W Enatls Tiling Tiing Options |
[T Screen Edge Dizplay Client Selection

tdain kenu Options

¥ Show Main Menu on 5 electar Main Meru Options

< Back I Hest > I Finizh Cancel Help

Terminal Interface Options Page

A terminal using MultiSession will need to have a method to switch between sessions. This is configured on
the Terminal Interface Options page. For terminals using TermSecure, additional Main Menu options are
available, as shown. See Terminal Interface Options for a terminal for a comparison.

Group Selector Options allow on-screen switching of sessions.

e Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

Analytics
Analytics
Reports

Tile
Main Menu

On-Screen Group Selector
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e Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

e Selector Options button will launch the Group Selector Options window that allows configuration of
the on-screen Group Selector.

Group Selector Options |

v fto-hide Group Selector

[ Tile on Group Selectar activation

Cancel |

Group Selector Menu Size M armnal j

Group Selector Options Window

The Auto-hide Group Selector checkbox, if selected, will hide the Group Selector until the mouse is
move to that space.

The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients when
the auto-hid selector is chosen. This allows the user to select from the available sessions.

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector
font.

Main Menu Options allow on-screen switching of sessions.

e Show Main Menu on Group Selector - This checkbox, if selected, will display the TermSecure Main
Menu as an option on the Group Selector drop-down.

e The Main Menu Options button will launch a window for Main Menu settings.

Main Menu Options E

[ allow reboot £ restart

¥ Show virtual Keyboard Cancel |

Main Menu Options

The Main Menu Options window has several settings.

e Allow reboot/restart — This checkbox, if selected, will add a Reboot and a Restart button on the
main TermSecure login window.

e Show Virtual Keyboard — This checkbox, if selected, will prompt the display of a virtual keyboard for
TermSecure logins. This is helpful for thin clients with touch screens.

The Allow reboot/restart checkbox, if selected, will add a Shut Down button to the TermSecure Main Menu.
The Shut Down button leads to a menu with a Restart and Reboot button.
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MAAIN METU

Switch User Log Off | ShuDown | About |

Main Menu with Shut Down Button

Once the user logs out, a Shut Down button will appear on the Main Menu. Selecting the Shut Down button
will launch the Shut Down Menu.

Shut Down

Restart | Rehoot | - Cancel |

Shut Down Menu

The Shut Down window has two buttons.

e Restart, when selected, will log off the TermSecure User, reload the configuration and load any
changes.

e Reboot, when selected, will log off the TermSecure User, power off the terminal and reload firmware
and configuration.

1 2 3 4 5 g 7 8 a 0 - = Y '
Tab | q | w | @ r 1 W u | 0 p [ ] Dhal
a 5 d f g h i k I : ' Return

Shift z X c W b n i : f

Temirese Log On
Em=r User hlame

ar
“con Your Hadge

Terminal Virtual Keyboard
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If the Show Virtual Keyboard checkbox is selected a virtual keyboard will be displayed on the terminal. This
is helpful for touch screen users.

Select OK to save setting or Cancel to close without saving.

26.10.1.2 Main Menu Hotkey - Terminal Configuration Wizard

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure
checkbox is checked on the Terminal Server Specification page.

= Terminal Configuration Wizard x|

Hotkey Configuration H

Configure the hotkeys to apply ta thiz terminal
A

— Terminal Hotkeys

[ Enable Instant Failover Hotkeys Change Hotkeys |
[ {Enable Display Client Hotkeys Change Hotkeys |
IV Enable Tiling Hotkey Change Hatkey |
¥ Enable Main Menu Hotkey Change Hatkey |

¢ Back I Hest > I Finizh Cancel Help

Hotkey Configuration — TermSecure Enabled

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination to be
changed.
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Select Hotkeys

— Switch Uszer Hotkep

% Control Key I m LI

Al kKey

Select HotKeys Window for Main Menu

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key
radio button or using the drop-down to select another hot key.

Select the OK button to continue or the Cancel button to close without accepting changes.

MAS I BAER L

Main Menu

The Main Menu can be launched with the Ctrl+ m hotkey if the Enable Main Menu Hotkey checkbox is
selected.

26.11 Card and Badge Configuration for a
TermSecure User

TermSecure allows the use of USB drives and RFID cards as login devices at terminals. This is configured on
the Card/Badge Information page of the TermSecure User Configuration Wizard. The TermSecure
Users Configuration Wizard can be launched by double clicking on a TermSecure User in the ThinManager
tree or by right clicking on the TermSecure Users branch of the tree and selecting Add TermSecure User.
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x|
Card / Badge Information }ﬁ"

Enter card/badge information if uger haz one,
A

¥ This user will uze a card, badge, or other device to log in

— Card / Badge Information

Enter Card/Badge |0 number

[~ Ahways Prompt for Password

< Back I Ment » I Finizh Cancel Help

Card / Badge Information Page
e This user will use a card, badge, or other device to log in - This checkbox, if selected, enables
the use of a USB device, card or badge to login to a terminal.

o Enter Card/Badge ID number - This field is for the unigue identification number of the ID device.
This can be filled manually or automatically. See Automatic Card/Badge ID Number Entry and Manual
Card/Badge ID Number Entry for instructions on the methods.

e Always Prompt for Password - This checkbox, if selected, will require a password in addition to the
ID device to login to a terminal as a TermSecure User.

26.11.1  Automatic Card/Badge ID Number Entry

ThinManager can be configured to automatically add the Card/Badge ID number. There are a few conditions
that need met to allow this to happen.

e The Display “Create New User” dialog for unknown users check box on the Options page
must be selected.

e The terminal must use Display Clients.

e The terminal needs the Enable TermSecure checkbox on the Terminal Specification page of
the Terminal Configuration Wizard.
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e The USB Drive module, RF Ideas pcProx Module, or Wavetrend Tag Reader Module need
added to the terminal. The USB Drive module needs the Use with TermSecure parameter set to
Yes.

e The user needs to scan the card or insert the USB drive to start the TermSecure Configuration
Wizard.

Automatic Card/Badge use starts with the enabling of the Create New User dialog box. This is configured on
the Options window that is opened by selecting View > Options.

N |

— General Ophions

¥ Display "Create Mew Teminal* dialog for unknown terminals.

¥ Display "Create Mew User' dislog for unknown uzers.

— loon Optioks

[ Minimize ta the System Tray.

— License Options

Wiarn i licenze will expire within I'I 0 day|z].

A walue of O dizables warning.

cros |

Options Window

The Display “Create New User” dialog for unknown users check box, if selected, will launch the
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key
or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting an
undefined USB key will launch the TermSecure User Configuration Wizard with the Enter Card/Badge ID
number automatically filled in.
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= TermSecure User Configuration Wizard x|
TermSecure User Replacement m
(=

Agzign thiz card number to an existing wzer or create a new uzer

Mew Card Mumber - 133307151

Click “szign Card Humber to Existing Usen'' to replace the card number of
an exigting uzer. To create a new uger click "MHext',

Agzign Card Mumber to Existing User

TemSecure Lzer to replace;

< Back Mest » Finizh Cancel Help

TermSecure User Configuration — TermSecure User Replacement

When a new card is scanned or a new USB key is inserted into a USB slot on the terminal the TermSecure
User Configuration is launched with an option to assign the card to an existing user.

Selecting Next will open the TermSecure User Configuration Wizard and allow a new TermSecure user to be
configured.

Selecting Assign Card Number to Existing User will launch the Select TermSecure User to replace
window to assign the card/badge number to an existing TermSecure User account.

Automation Control Products ThinManager 5.0 Help Manual Permissions e 515



Select TermSecure User o replace

x]
El- U_sers QK I

(- East
- Moith Cancel
& South
“West

Jefferzon
M adison
i Marnoe

Select TermSecure User To Replace Window

Highlight the desired TermSecure user and select OK. The wizard will display the TermSecure User
Information page with the selected user entered.
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& TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

X

— TemSecure User Information

Izer Mame I.-’-'-.dams

Pazzwiord I

Werify Pazsword I

Fazsword Options |

— Eroup
I Change Group |
— Copy Settings
[T Copy Settings fram another User Copy Franm |
< Black | Mest » | Finizh | Cancel

TermSecure User Information Page

If a TermSecure user was selected for the badge, the user will be displayed in the User Name field of the

TermSecure User Information page.

Selecting Next will continue with the configuration and show the Card/Badge Information page.
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= TermSecure User Configuration Wizard x|

Card / Badge Information bq

Enter card/badge information if uzer haz one.
A

¥ Thiz user will uze a card, badge, or other device to log in

— Card / Badge Information

Enter Card/Badge |0 number

[~ Aways Prompt for Password

< Back I Mest » I Finizh Cancel Help

Card/Badge Information Page

The card, badge, or USB drive number will be entered in the Enter Card/Badge ID number field.

Select Back to change the configuration, select Next to continue, select Finish to accept the changes, or
select Cancel to cancel changes.
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26.11.2 Manual Card/Badge ID Number Entry

Although the easiest method for assigning a card or badge is automatic as described in the Automatic
Card/Badge ID Number Entry section, ThinManager can be configured for manual entry

If the Display “Create New User” dialog for unknown users check box on the Options window is
unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge 1D
number is accessible in the event log. To configure a terminal to allow a device one needs to:

e Turn the Event Log on

e Have the appropriate hardware on the terminal, either a USB port or a ProxCard reader.
e Add the appropriate module.

e Use the device once to have the device’s identifier entered to the event log.

e Openthe TermSecure User Configuration Wizard and enter the ID number to tie the TermSecure
User to the device.

e Login with the ID device.

26.11.2.1 Event Log
The Event Log is configured in the ThinManager Server Configuration Wizard.

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server icon in
the tree, or highlighting it and selecting Edit > Modify from the menu.

Navigate to the Historical Logging page.
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52 ThinmManager Server Configuration Wizard x|

Histoncal Logging H

Select the itemsz to log and how long to maintain the logged
inforrmatior. A

— Higtarical D ata

b aintain Higtoncal Log For I-I days

Clear Hiztary

—Ewvent Log

b aintain Event Log for I? dayz

Chooze events tolog

I Terminal Server Events

¥ Temminal Events

¥ Teminal Configuration changes
v TemSecure User Configuration changes

Clear Event Lag |

< Back I Hest > Finizh Cancel | Help |

Historical Logging Page

All events may be selected to be logged, but the Terminal Events checkbox is critical to the TermSecure
Device detection. Select the Terminal Events checkbox and select the Finish button.
26.11.2.2 USB Device Module

When using the USB drive as a TermSecure identifier, the USB Flash Drive Module needs added to the
terminal.

See USB Flash Drive Module for details.

26.11.2.3 ProxCard Reader Module

A ProxCard Reader works much the same as the USB device, but uses a different module, the RF Ideas
pcProx Module.

See RF Ideas pcProx Module for details.

26.11.2.4  WaveTrend Tag Reader Module

A WaveTrend Tag Reader works much the same as the USB device, but uses a different module, the
WaveTrend Tag Reader Module.

See Wavetrend Tag Reader for details.
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26.11.2.5 Device ldentifier Number
Next the ID device needs to be scanned or inserted to help find the ID number.
Insert the USB device or scan the ProxCard on the terminal.

A TermSecure message should be displayed.

Term3ecure Message

05deadiionnZ03000001236 Is Mot a Walid User D

TermSecure Message

The ID device will not work so the terminal will send a message with the ID device’s identifier number.
e Record this number.

This number is also entered in the event log if the Terminal Events were selected in the ThinManager Server
Configuration Wizard.

e Open ThinManager.
¢ Highlight the terminal in the tree and select the Event Log tab.

The ID for the device is entered in the log.
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52 ThinManager =] B3

Edit Manage Instal Tools View RemoteView Help

E'}E{ ':_'Z'bf"t .Eu:unfiguraticunl Mu:udulesl Schedulel Properties  Event Log | Shadu:uwl Hepu:urtl
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ThinManager Event Log

Next the ID number needs to be associated with the TermSecure User.
e Open the TermSecure User Configuration Wizard for the user you want to have use that ID device.

e Navigate to the Card / Badge Information page.
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Card / Badge Information Page

e Select the This user will use a card, badge, or other device to log in checkbox.
o Enter the ID Identifier from the earlier steps into the Enter Card/Badge ID number field.
e Select the Always Prompt for Password, if desired.

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use the
device.

¢ Insert the USB device into the USB port on the thin client or scan the ProxCard on the card scanner.
The USB device will log the TermSecure User into the terminal server.

e Open ThinManager.

e Highlight the ThinManager Server and select the Event Log tab.
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Event Log

The Event Log will show the results of the successful login. The terminal will have the TermSecure User
added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is
logged into.
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